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La utilización de animales para generar “conocimiento científico” es una práctica 

conocida desde la antigua Grecia, donde ya se realizaban disecciones de diversas 

especies animales con el fin de comprender su anatomía y fisiología. Con el paso del 

tiempo, los investigadores se dieron cuenta que los animales y los seres humanos son 

muy parecidos, estando dotados de los mismos órganos que desempeñan las mismas 

funciones de una manera similar. Por ejemplo, el ser humano comparte el 95% de los 

genes con el ratón, lo que le convierte en un modelo muy cercano al cuerpo humano. 

La investigación animal ha permitido a los científicos descubrir formas de curar 

enfermedades y prolongar la vida del ser humano, desempeñando un papel fundamental 

en casi cada uno de los descubrimientos de los últimos 20 años.  

Gracias a la experimentación en animales se han desarrollado vacunas, como la de la 

viruela, tétanos o la polio entre otras, trasplantes, transfusiones sanguíneas, técnicas 

quirúrgicas… 

Dentro del campo de la farmacología, se utilizan animales para probar medicamentos 

antes de ser utilizados en humanos. Para ello se recurre a modelos animales de 

enfermedad, que consisten en “provocar” en el animal una enfermedad, como, por 

ejemplo, cáncer, tuberculosis, gripe, asma o hipertensión arterial, entre otras. 

De esta forma se descubrió la insulina y se han desarrollado multitud de fármacos como 

los anestésicos modernos, o los tratamientos antirretrovirales altamente activos, entre 

otros. 

En el proceso de evaluación preclínica de los fármacos, lo más relevante es constatar 

que es lo que “hace” o “no hace” el medicamento. Para ello, existen múltiples 

procedimientos entre los que se encuentran el “órgano aislado”, el animal vivo, como 

veremos en esta práctica, y los modelos de enfermedad en animales. 

No obstante, en los últimos años se ha estado trabajando intensamente en alternativas 

para la sustitución de animales en la experimentación: técnicas fisicoquímicas, 

utilización de organismos de menor escala biológica, cultivos de células, tejidos y 

órganos, y simulaciones por ordenador. 

Estos modelos “in vitro” son una parte importante en el desarrollo de medicamentos, y 

aunque no siempre será posible prescindir de los animales en la experimentación, si se 

podrá en algunos casos disminuir el número empleado en cada ensayo. 
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El objetivo de esta práctica es analizar el efecto de ciertos fármacos en un modelo de 

simulación de baño de órgano aislado.  

El baño de órganos aislado es la herramienta farmacológica clásica para evaluar la 

relación concentración-respuesta en el tejido contráctil. Aunque una variedad de 

herramientas a nivel molecular se ha desarrollado en las últimas décadas para evaluar 

las respuestas a nivel celular, el ensayo en baño de órganos es aún considerada una 

herramienta valiosa para la optimización y para la elucidación del mecanismo de acción. 

Además, los ensayos en baño de órganos son ampliamente utilizados en estudios 

preclínicos. 

La aplicación más común de los ensayos en baño de órganos es la investigación 

cardiovascular, usando anillos aislados de aorta, tejido cardiaco (músculo papilar, 

ventrículo izquierdo) o arterias. Para el estudio de las afecciones gastro-intestinales se 

utilizan con frecuencia las preparaciones de íleon y de colon, pero también puede ser 

estudiado el músculo antral gástrico y el esfínter. 

Con la realización de esta práctica, el alumno reforzará su conocimiento sobre diferentes 

fármacos ya estudiados en las clases de teoría. Para ello, se trabajará con diferentes 

simulaciones informáticas. 

Como apoyo para esta práctica se puede visualizar en la siguiente dirección una píldora 

de conocimiento sobre la experimentación animal en Farmacología:  

 

Píldoras de conocimiento 

 

https://www.youtube.com/playlist?list=PLSbo9kXA_LcwMI1u-8XkiegUZse8zDRWk
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1. SIMULACIONES PARA BAÑO DE ÓRGANO AISLADO: 
PROGRAMAS INFORMÁTICOS.  
 
Las simulaciones informáticas son fundamentales para la docencia práctica en la 

asignatura de farmacología. En esta práctica vamos a emplear el simulador informático 

“Organ Bath Simulation V3.6 (OBSIM)”. 

El programa OBSIM simula un experimento farmacológico clásico, in vitro, utilizando 

uno de los cuatro tipos diferentes de tejidos: íleon de cobaya, yeyuno de conejo, biventer 

cervicis de pollo y arteria de rata.  



 

5 
 

Práctica 4 – Baño de órgano aislado  

 

Los experimentos farmacológicos in vitro en órganos o tejidos aislados proporcionan un 

medio para descubrir o cuantificar los efectos de los fármacos en tejidos específicos 

antes de su aplicación en humanos o en animales vivos. Las propiedades de la mayoría 

de los medicamentos actualmente en uso se aclararon utilizando este método y, los 

experimentos in vitro continúan siendo una etapa esencial en el proceso de 

descubrimiento de fármacos. 

 

Tipos de Tejidos 

Hay cuatro tipos de tejidos disponibles para su estudio: 

Íleon de cobaya: El íleon de cobaya es una sección cortada de la región del íleon del 

tracto gastrointestinal de una cobaya. El músculo liso dentro del íleon se contrae en 

respuesta a la aplicación de una variedad de agonistas. También tiene nervios en su 

interior que pueden ser estimulados eléctricamente para producir contracción. 

Biventer cervicis de pollo: El biventer cervicis de pollo es un músculo esquelético del 

cuello de un pollo joven. Se diseca con el nervio que lo inerva intacto. Se puede hacer 

que se contraiga mediante la aplicación de agonistas o mediante la estimulación 

eléctrica de su nervio. 
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Anillo arterial de conejo: El anillo arterial de conejo es una sección cortada de una arteria 

de conejo y se adjunta a un transductor de fuerza. Se puede hacer que se contraiga 

mediante la aplicación de KCL o del agonista noradrenalina. La arteria puede volver a 

relajarse aplicando una serie de antagonistas. 

Yeyuno de conejo: El yeyuno de conejo (preparación de Finkleman) es una sección 

cortada de la región del yeyuno del tracto gastrointestinal de un conejo. Se contrae 

espontáneamente y estas contracciones pueden ser inhibidas mediante la aplicación de 

agonistas adrenérgicos o mediante la estimulación del suministro nervioso simpático. 

 

1. Experimento 

El tejido en estudio se sumerge en un baño de órgano con un pequeño volumen de 10 

ml que contiene una solución salina fisiológica, Krebs-Henseleit (K-H), que se asemeja 

a los fluidos extracelulares que normalmente bañan el tejido in vivo. El baño de órgano 

está contenido dentro de un baño de Perspex que contiene agua del grifo, mantenida a 

una temperatura cercana a la temperatura corporal normal del animal (37°C) mediante 

un calentador y un termostato. 
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Los fármacos se pueden aplicar al tejido pipeteando pequeños volúmenes de solución 

que contienen el fármaco directamente en el baño de órgano y se eliminan al enjuagar 

el baño de órgano con solución fresca de un depósito que contiene solución K-H. Al abrir 

el grifo del depósito, la solución fisiológica fluye a través de la bobina de calentamiento 

hacia el baño de órgano. Una mezcla de oxígeno (95%) y dióxido de carbono (5%) se 

burbujea tanto en el depósito como en el baño de órgano para proporcionar oxígeno y 

mantener el pH del tejido. El tejido también se puede estimular eléctricamente utilizando 

un estimulador conectado a un par de electrodos colocados a ambos lados del tejido 

dentro del baño de órgano. 

 

El tejido está unido a un transductor de fuerza que genera una señal eléctrica 

proporcional a la fuerza contráctil generada por el tejido cuando se aplica un fármaco. 

Este transductor está conectado a un amplificador que aumenta los pequeños voltajes 

producidos por el transductor a un nivel adecuado para su medición por la computadora. 

La señal amplificada se alimenta luego a un convertidor analógico-digital (A/D) que 

digitaliza la señal y la almacena en la computadora, bajo el control de un programa de 

registro de gráficos digitales. 

 

2. Iniciar un experimento. 

a) Para comenzar un nuevo experimento, haz clic en el botón de "Nuevo Experimento" 

y selecciona el tipo de tejido que se colocará en el baño de órgano desde la lista de 

Tipos de Tejido. 

 

b) Haz clic en el botón de "Grabar" para iniciar el funcionamiento del registrador 

gráfico. 

c) Selecciona y aplica fármacos de la lista de Agonistas, Antagonistas o fármacos 

Desconocidos disponibles. 



 

8 
 

Práctica 4 – Baño de órgano aislado  

 

4. Estimulación eléctrica 

Para estimular eléctricamente el tejido, selecciona "Nervio" para estimular las fibras 

nerviosas que inervan el tejido muscular o "Músculo" para estimular directamente las 

fibras musculares dentro del tejido. Luego, haz clic en el botón "Encender" para 

comenzar a estimular a intervalos regulares. 

 

Haz clic en el botón "Apagar" para detener la estimulación. 

 

5. Uso de agonistas 

Para agregar un fármaco agonista al baño de órgano: 

a) Selecciona la página de Agonistas. 

 

b) Selecciona el tipo de agonista a aplicar de la lista de agonistas disponibles. 

c) Selecciona la concentración de la solución del fármaco a aplicar en la lista de 

"Solución de Reserva" (Stock Soln.). 

d) Introduce el volumen (entre 0 y 1 ml) de la solución de reserva que se va a aplicar 

en el cuadro de Volumen. 

e) Haz clic en el botón "Agregar al Baño de Órganos" para inyectar el volumen 

seleccionado de la solución de reserva del agonista en el órgano. 
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f) Cuando la respuesta del tejido en el registro gráfico alcance un estado estable (o 

después de 30 segundos si no se ha producido ninguna respuesta), haz clic en el 

botón "Enjuagar Reservorio al Baño" para eliminar el agonista del baño de órgano. 

Notas: 

Los agonistas son fármacos que, cuando se aplican al tejido, provocan una respuesta 

(contracción en el caso de los tejidos que normalmente se estudian en baños de 

órganos) al unirse a receptores específicos en la superficie de las células dentro del 

tejido. 

 

6. Uso de antagonistas 

Para agregar un fármaco antagonista al baño de órgano o al reservorio de solución de 

Krebs: 

a) Selecciona la página de Antagonistas. 

 

 

b) Selecciona el tipo de antagonista a aplicar de la lista de antagonistas disponibles. 

c) Selecciona la concentración de la solución del fármaco a aplicar en la lista de 

"Solución de Reserva" (Stock Soln.). 

d) Introduce el volumen (entre 0 y 1 ml) de la solución de reserva que se va a aplicar 

en el cuadro de Volumen. 

e) Selecciona "Baño de Órganos" en la lista de "Añadir a" si el antagonista se va a 

aplicar directamente al baño de órgano. Selecciona "Reservorio" si el fármaco se va a 

agregar al reservorio de solución de Krebs. 

f) Haz clic en el botón "Agregar" para inyectar el volumen de la solución de reserva 

seleccionada del antagonista en el baño de órgano o en el reservorio. 
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Notas: 

Los antagonistas son fármacos que bloquean las acciones de los agonistas en el 

tejido, reduciendo o impidiendo la respuesta del tejido. Por lo tanto, la aplicación de un 

antagonista no tendrá un efecto aparente en el tejido en el baño de órgano a menos 

que un agonista esté presente (o el tejido esté siendo estimulado). Los antagonistas se 

estudian típicamente observando los efectos que un antagonista tiene sobre diferentes 

concentraciones de un agonista elegido. Para evitar la necesidad de aplicar 

repetidamente el antagonista al baño de órgano antes de cada agonista, generalmente 

se agrega al reservorio de solución de Krebs utilizado para enjuagar el baño de órgano 

entre aplicaciones de agonistas. 

 

7. Medición de la respuesta tisular 

Para medir la amplitud máxima de las contracciones del tejido: 

a) Haz clic en el botón "Detener" para detener la grabación. 
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b) Utilizando la barra de desplazamiento en la parte inferior de la pantalla del gráfico, 

selecciona una sección de la grabación que contenga la contracción del tejido que 

deseas medir. También puedes ajustar el tamaño de la ventana de visualización 

ingresando una nueva duración en el cuadro de "Tamaño de la Ventana" o expandir o 

contraer la ventana usando los botones de flecha. 

c) Arrastra el cursor de medición en la pantalla del gráfico hasta el punto de la traza de 

la grabación que deseas medir (el pico de las respuestas estimuladas por nervios o la 

meseta de las respuestas a los agonistas). La fuerza contráctil en el punto del cursor 

(en unidades de gramos) se muestra debajo del cursor. 
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8. Opciones de menú 

 

• File > Print: Permite imprimir una copia de la grabación mostrada. Seleccione “Print” 

en el menú “File”. Para seleccionar una impresora específica o cambiar la 

configuración de la impresora, seleccione “Printer Setup” en el menú “File”. 

• Edit > Copy Data: Para copiar los puntos de datos del registro visualizado en el 

portapapeles de Windows y poder pegarlos en una hoja de cálculo o en un programa 

de trazado de gráficos, seleccione “Copy Data” en el menú “Edit”. 

• Edit > Copy Image: Copia una imagen de la grabación visualizada para poder 

pegarla en un documento de Word o en una presentación de PowerPoint, seleccione 

“Copy Image” en el menú “Edit”. 

• File > Save Experiment: Guarda la grabación del experimento actual en un archivo 

de datos, seleccione “Save Experiment” en el menú “File” e introduzca el nombre de 

un nuevo archivo de datos en el cuadro de diálogo. 

• File > Load Experiment: Cargar una grabación previamente guardada de un archivo 

de datos, seleccione “Load Experiment” en el menú “File” y seleccione el archivo de 

datos de la lista que aparece en el cuadro de diálogo. 

 

2. ACTIVIDADES PARA REALIZAR USANDO EL PROGRAMA 
DE SIMULACIÓN DE ÓRGANO AISLADO. 
 

1. Obtención de la curva concentración-respuesta de acetilcolina. 

Adicionad concentraciones acumulativas crecientes de las distintas soluciones de 

acetilcolina (0,10 ml de cada solución en un baño de 10 ml). Cada concentración se 

añade al baño una vez alcanzado el efecto máximo de la anterior. Al finalizar la adición 

de todas las concentraciones, se lava la preparación. 
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Actividad 1. Cumplimentar las siguientes tablas con los resultados obtenidos 

empleando el Excel incluido en la práctica.  

Ach (M) Log Efecto (g) % efecto 

1,00E-10    

1,00E-09    

1,00E-08    

1,00E-07    

1,00E-06    

1,00E-05    

1,00E-04    

1,00E-03    

1,00E-02    

 

   CCR I  
log CE50  
CE50 (M)  

 


	8. Opciones de menú

